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The Role of the Laboratory -- 
Public Health and Forensic 

YOUR NAMES HERE 

Presenter
Presentation Notes
NOTES:

This set of slides is intended as a template for a pair of experienced, senior representatives of the public health and forensic laboratories to speak from in the Forensic Epidemiology course. The audience will consist of a mixture of public health, law enforcement, fire, and other first responder professionals who will not be familiar with most laboratory terminology or jargon. They need to know what your laboratory can do for them in an investigation of a bioterrorism or similar event, and how to access those services. 

As a template, these slides are designed to be customized to be correct for the jurisdiction(s) where the course is being held. You should go through and, as far as possible, answer the questions posed in the bullets, or customize them to local practices and organizations.  Feel free to create more slides, if you need to, to cover the issues in the templates.  Also feel free to add additional topics as needed for local use.  Experience has shown, however, that people without a laboratory background will benefit greatly by hearing from you about the topics outlined on this template.  

You may leave the slides as they are, to prompt you to say the right things about these issues, but we strongly recommend that you customize them.  The participants in the course should have a copy of your slides in their notebooks, and you will want to be sure that they take home the right information with them.  

Note that this presentation should last approximately 50 minutes, including a time for questions and answers. As a result, it may be necessary to remove some of the topics covered. This should be done at the discretion of the local planning committee and the Laboratory presenters.

Add your own name as the presenter and your own subtitle if you like. Text that is designed to be replaced or edited is colored in RED.  Other material should be edited or customized as needed.  

A space is provided in each slide for your organization’s seal or logo. In order to access the area in which the logo will reside, you must go to the slide master. To do this go to the View menu, then select Master, Slide Master. Replace the “Insert seal or logo here” generic logo on the slide master with the appropriate logo for your jurisdiction’s laboratory. This will replace the logo on all but the title slide. To change the logo on the title slide, go to the View menu, then select Master, Title Master. Replace the “Insert seal or logo here” generic logo on the title master with the appropriate logo for your jurisdiction’s laboratory. 

Make sure all the text is legible (e.g., white on blue background, not red on blue) when slides are complete. To change the color of the text, highlight the text that needs to be changed, go to the Format menu, then Font, then change the color to white. 

Currently, the date is located in the footer. To change the date from the generic “Date” to the date of the presentation, go to the View menu, then select Header and Footer.  Under footer, replace “Date” with the appropriate date, then select Apply to All. 

To change the presenter’s name and change the color of the text in the footer you must go to the slide master. To do this, go to the View menu, then select Master, Slide Master. Highlight the generic “Presenter’s name”, change it to the reflect the name of the presenter, then go to the Format menu, select Font and change the color to white. Highlight <footer>, go to the Format menu, select Font and change the color to white.
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Lecture Goals 

• Describe roles of the Public Health and Forensic 
(crime) laboratories 

• Understand laboratory procedures in suspected 
BT events 

• Understand chain of custody as applied to 
laboratory specimens  

Presenter
Presentation Notes
NOTES:

The purpose of this slide is to describe the goals of the lecture.
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Public Health Laboratory 

   
Add your name here 

Presenter
Presentation Notes
NOTES:

Name of public health lab representative goes on this slide (as well as on the title slide).  Here you have room to put your phone number, your picture, or other brief contact information. 
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• State Labs are reference labs within the 
state 

• Mandate by Congress  
• Experience with biological agents of 

concern and outbreak investigations 
• Link between local laboratory level and 

CDC /federal agencies 

Why is the Public Health 
Laboratory (PHL) Involved? 

Presenter
Presentation Notes
NOTES:

OPPORTUNITY TO EXPOUND.

PHL=Public health laboratory
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Roles of the State PHL 

• Disease identification and outbreak 
investigation 

• Reference services (additional, definitive 
testing on isolates and specimens) 

• Specialized testing 
• Direct services 
• Environmental testing 
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Roles of the State PHL 
(continued) 

• Rapid testing 
• Improvement of clinical laboratories 

throughout the state 
• Applied research 
• Support of disease surveillance and 

epidemiology investigations 

Emergency Preparedness and 
Response 

Presenter
Presentation Notes
NOTES:

"In addition to these roles, we have some unique roles that we deal with…”
* Monitoring of Community Health Status
* Assessment of Diseases of Public Health Significance
* Early Intervention in the Disease Process
* Assurance of Safe and Disease-free Communities
* Emphasize what your lab does.

OPPORTUNITY TO EXPOUND.
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The Laboratory Response 
Network 

• Network supports response to all kinds of public 
health emergencies, but especially detection and 
response to BT 

• Includes both public and private labs 
• Labs test according to consensus protocols 
• Timely and accurate testing and reporting 
• Linked with local, state, and federal agencies 
• Supported by CDC and FBI 

Presenter
Presentation Notes
NOTES:

* Chemical agents work more quickly than biological agents. Typically, the disease-state is limited by the effects of the initial exposure.  
* Chemical agents are frequently handled by HAZMAT.  
* There will be a LRN for Chemical Terrorism, also, but not talking about that today.
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LRN Laboratory Levels 

LEVEL A:  Clinical Labs 

LEVEL B: Public Health Labs 

LEVEL C: Typing Labs, Public Health Labs 

LEVEL D: CDC 

Presenter
Presentation Notes
NOTES:

* Other level D labs at the federal level (ex. DoD) exist, but serve as surge capacity/overflow only.
* Keep in mind that if you are clinical lab, a BT situation may occur involving you, whether or not you are officially part of this network.  
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LRN Safety & Proficiency  
Adequate to... 

Level A Labs - Use BSL-2 

Level B Labs -     
BSL-3 Recommended 

Level C Labs - 
Work at BSL-3 

Level D Labs- 
Work at BSL-4 

Confirm, Validate and Archive.  Perform high 
level characterization. Probe for universe of 
agents.  

Rapid identification. Rule-in and Refer.  

Perform susceptibility testing. Isolate.  
Identify. Rule-in and Refer.  

Detect early (presumptive 
cases). Rule-out or Refer. 

Presenter
Presentation Notes
NOTES:

* Level A Labs - Enhanced medical lab protocol.
* Level B Labs - Work at BSL-2 with BSL-3 Practices.
* Level C: Probe, type, identify subspecies, perform toxigenicity testing, etc.
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Public Health Laboratory(ies) 
Serving this Community 

• Use this slide to describe what public health laboratories 
serve this community, what agency they are part of, 
where they are located. 

• Describe how LRN works in this community – does this 
PH lab support other states, or get support from other 
states? 

Presenter
Presentation Notes
NOTES:

Use this slide to describe what public health laboratories serve this community, what agency they are part of, and where they are located.

Describe how LRN works in this community – does this PH lab support other states or get support from other states?
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Services Usually Offered by 
Public Health Laboratories  

• Primary analysis of specimens from people in 
epidemiologic/enzootic investigations 

• Primary analysis of specimens from people getting 
clinical services in health departments 

• Referral services for hospital and clinical laboratories to 
help identify unusual or important organisms  

• Regional referral services as part of LRN 
• May do breathalyzer and blood alcohol testing under 

contract 
• Screening of newborns for metabolic disorders 
• Testing of environmental samples 

Presenter
Presentation Notes
NOTES:

This slide describes services usually offered by the public health laboratory.
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Services Offered by this 
Public Health Laboratory 

• Use this slide (or two) to briefly list the BT-
relevant services your lab can provide.   

• Rather than use technical names of tests, 
describe functions (see notes) 

Presenter
Presentation Notes
NOTES:

Examples of how to describe services:
“We can determine whether a bacteria grown from a skin lesion is anthrax in __ hours.”
“We can determine whether a skin lesion is due to smallpox in ___ hours.” 
“We do not have the technology to do X ourselves, but have an agreement with the Y laboratory to do it for us with Z turnaround time.” 
“We can tell if multiple people with an enteric infection like salmonella have the same strain in ___ hours.”

Or another way to say this is to list the agent and then the testing/time frame. Include the technical name of the test because this does have meaning for many responders. For example:
 
Anthrax:	Presumptive testing (PCR): 4-6 hours
		Confirmatory testing (culture): 24-48 hours
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Public Health Laboratory 
Authority and Regulation 

• Use this slide to indicate what authority, if any, the state 
public health laboratory has to require submission of 
clinical specimens or isolates for confirmation or typing  

• Also describe role, if any, of state public health 
laboratory in licensing of clinical laboratories and in 
quality assurance testing of these labs.  

Presenter
Presentation Notes
NOTES:

Use this slide to indicate what authority, if any, the state public health laboratory has to require submission of clinical specimens or isolates for confirmation or typing.
 
Also describe role, if any, of state public health laboratory in licensing of clinical laboratories and in quality assurance testing of these labs. 
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Background and Training  
of Staff 

• Laboratories employ scientists with training as medical 
technologists and/or as microbiologists at the bachelor’s, 
master’s or doctoral level. 

• Also employ support staff, managers, data system 
managers, trainers 

• Use this slide to mention the most highly trained 
members of your lab’s staff and maybe some of their 
accomplishments. “Dr. So-and-so in our lab is the one 
who confirmed the anthrax diagnosis in the three 
patients from our state in late 2001.” 

Presenter
Presentation Notes
NOTES:

Use this slide to talk about the skills and training of your laboratory staff.
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Clinical Laboratory Testing 

• Preliminary testing occurs in physician’s 
office, emergency department or at a lab 
collection point 

• Commercial and hospital labs may make 
definitive identification of an organism 

• For unusual organisms the specimen is sent 
on to the State PHL 

• State PHL may make definitive identification 
or send to another lab in the LRN or to CDC 
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Lab Record Keeping 

• All these labs have careful protocols to 
document specimens, who they were collected 
from, status of testing, etc. 

• But these do not meet requirements of chain of 
custody 

• Labs need to know for which specimens chain of 
custody procedures need to be implemented 
because they may be evidence of a crime 
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Environmental Samples  
for BT Agents 

• Rapid field testing may be done by law enforcement, 
hazmat or PH workers 

• CDC has not yet endorsed any of the rapid field tests for 
BT agents 

• Specimens must always also be tested at Public Health 
Laboratories for definitive result 

• What environmental tests does this state public health 
lab perform? 

Presenter
Presentation Notes
NOTES:

What environmental tests does this state public health lab perform?
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Environmental Laboratory 
Testing  

• Specimens of water, food, air, dust, swabs, etc  
• If obtained in a public health investigation, will usually go 

to a public health lab (or Agriculture Dept lab) and then 
into the LRN as needed 

• If obtained in a law enforcement investigation, will 
usually go to forensic laboratory  
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Sample Submission  

• Use this slide to describe your agency’s 
procedure for obtaining, logging in, and 
processing specimens taken when a suspicious 
substance is found 

• Describe how you implement chain of custody 
requirements 

• Who makes the decision about sending a 
specimen to the PH lab for testing?  Is the lab 
itself in the loop on the decision-making? 

Presenter
Presentation Notes
NOTES:

Use this slide to describe your agency’s procedure for obtaining, logging in, and processing specimens taken when a suspicious substance is found.

Describe how you implement chain of custody requirements.

Who makes the decision about sending a specimen to the PH lab for testing?  Is the lab itself in the loop on the decision-making?
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Lab Results 

• Who gets results on specimens submitted to the public 
health lab? 

• Who is authorized to receive results if they request 
them? 

• How are they sent out? (phone call, written result, e-mail 
message, fax, file transfer?) 

Presenter
Presentation Notes
NOTES:

This is a hot topic in some communities. You may want to take this opportunity to talk about the steps you are taking to make sure the information gets promptly to those with most need to know – e.g., the people exposed in a particular location, as well as the agency that submitted the specimens from that location. 
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Local Examples 

• Examples of white powder hoaxes in this locale in fall of 
2001 

• Tests performed – pictures of kinds of specimens 
submitted 

• What do you want people to do in this community with 
unusual objects citizens are concerned about? 

• What kind of training do 911 dispatchers have in 
handling calls from citizens concerned about white 
powders?   

Presenter
Presentation Notes
NOTES:

Provide examples of white powder hoaxes in this locale in fall of 2001.

What tests were performed – pictures of kinds of specimens submitted

What do you want people to do in this community with unusual objects citizens are concerned about?

What kind of training do 911 dispatchers have in handling calls from citizens concerned about white powders?  
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How to Reach Us  

• Names and phone numbers for key public health 
laboratory contacts 

• Include 24-hour contact number(s) 
• Include cell-phone or pager numbers, e-mail addresses 

as appropriate 
• Give web site address for more information 

Presenter
Presentation Notes
NOTES:

List ways to reach the lab.
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Forensic Laboratory 

   

Add your name here 

Presenter
Presentation Notes
NOTES:

Name of forensic lab representative goes on this slide (as well as on the title slide).  Here you have room to put your phone number, your picture, or other brief contact information.
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Forensic Labs 

• Use this slide to describe which forensic 
laboratory serves this community – what 
organization is it part of? 

• Describe also what services this laboratory 
generally provides in criminal investigations 

• Describe what services this lab specifically 
provides that can support BT investigations  

• (Use more than one slide if necessary) 

Presenter
Presentation Notes
NOTES:

Use this slide to describe which forensic laboratory serves this community – what organization is it part of?

Describe also what services this laboratory generally provides in criminal investigations.

Describe what services this lab specifically provides that can support BT investigations (Use more than one slide if necessary).
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Additional Information about 
Forensic Labs 

• Describe where you get services you need that exceed 
your capabilities 

• How does the forensic laboratory relate to the medical 
examiner or coroner? 

• Who does forensic chemical analysis? 
• How do labs associated with different levels of law 

enforcement agencies relate to each other (e.g. city, 
state and FBI forensic labs)? 

Presenter
Presentation Notes
NOTES:

Describe where you get services you need that exceed your capabilities.

How does the forensic laboratory relate to the medical examiner or coroner?

Who does forensic chemical analysis?

How do labs associated with different levels of law enforcement agencies relate to each other (e.g., city, state and FBI forensic labs)?
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Forensic Lab Authority and 
Regulation  

• Are health care organizations required to supply 
certain kinds of materials to forensic laboratories 
in support of criminal investigations? 

• What kinds of deaths become coroner’s cases 
requiring autopsies in this community?  

• What kinds of information developed by forensic 
labs are a matter of public record, if any? 

• Other relevant regulations or laws? 

Presenter
Presentation Notes
NOTES:

Are health care organizations required to supply certain kinds of materials to forensic laboratories in support of criminal investigations?

What kinds of deaths are coroners’ cases in this community, where autopsies are required?

What kinds of information developed by forensic labs are a matter of public record, if any?

Other relevant regulations or laws?
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Background and Training  
of Staff 

• Describe the training and background of your technicians 
and scientists. 

• What other kinds of workers are employed in a forensic 
lab? 

• Do lab technicians go to crime scenes to collect 
specimens or is there a separate unit that does this? 

• Are forensic laboratory technicians trained and equipped 
to collect specimens in crime scenes with bacteriologic 
or toxic risk, or do others collect them? 

Presenter
Presentation Notes
NOTES:

Use this slide to describe the training and background of the technicians and scientists in your forensic lab.
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Services Offered by This 
Forensic Laboratory 

Customize this list to your capabilities 
• Fingerprinting and maintenance of databases 
• Analysis of hair and other human materials 
• Microscopic and chemical analysis of fiber, paper and 

other materials 
• DNA testing of human specimens 
• Blood types and other tissue testing 
• Ballistics 

– Projectile characterization 
– Weapon analysis 
– Explosive debris analysis 

• Etc?? 

Presenter
Presentation Notes
NOTES:

Use this slide to list your capabilities. Please add or remove capabilities as you need.
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Sample Submission 

• How do forensic laboratory staff obtain their specimens 
for testing?   

• When do they go to a crime scene? 
• How would an envelope containing both a threatening 

letter and a suspicious white powder be handled? 
• Process taken when a suspicious substance is found 
• Preservation of physical evidence and chain of custody 

considerations, including standards, in crime lab 

Presenter
Presentation Notes
NOTES:

Envelope containing both a threatening letter and a white powder: in many jurisdictions the forensic laboratory would not want to receive the envelope and letter until the public health laboratory has examined and cultured it and either determined that there are no pathogens present or sterilized it.  If the latter, the forensic laboratory may want to be involved to be sure that the features of the letter and envelope that are important for forensic examination are not disturbed.  
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Lab Results 

• Who gets results on specimens submitted to the forensic 
lab? 

• Who is authorized to receive results if they request 
them? 

• How are they sent out? (phone call, written result, e-mail 
message, fax, file transfer?) 

Presenter
Presentation Notes
NOTES:

Who gets results on specimens submitted to the forensic lab?

Who is authorized to receive results if they request them?

How are they sent out? (phone call, written result, e-mail message, fax, file transfer?)
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Chain of Custody  

• Describe how your laboratory implements chain of 
custody. 

• What are common errors in specimen collection or 
handling that make it impossible to use forensic 
evidence in court? 

Presenter
Presentation Notes
NOTES:

Describe how your laboratory implements chain of custody.

What are common errors in specimen collection or handling that make it impossible to use forensic evidence in court?
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Field Response Protocols 
Chain of Custody Issues in the Field and the 

Laboratory 

• The need for chain of custody 
– “Everything goes to court…” 

• Field vs. laboratory chains 
– Lock and Key Requirement 
– Tampering vs. Accidental interference 

• University Laboratory Example… 

• The complete chain 
– He who collects, testifies… 

Presenter
Presentation Notes
NOTES:

Use this slide to discuss chain of custody issues in the field and the laboratory. Please list or explain any examples you can think of that will illustrate the importance of chain of custody. 
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Field Response Protocols 
Biological Response Kits and Materials 

For Field Collection and Screening 

• Overpacking Requirements 
– Diagnostically Appropriate 
– Legally Appropriate 

• Sterile vs. Certified Clean 

• Field Screening Procedures 
– Protecting Personnel 
– Protecting Laboratory Equipment  
 and Capability 
– Noting the Results for Lab Personnel 
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Field Response Protocols 
Forensic Laboratory Testing 

vs. Diagnostic (Health) Lab Testing 

Forensic and Diagnostic Labs have 
different goals: 

• Forensic Lab Testing 
– DNA Strain Comparison 
– Chemical Analysis (Explosives) 

– Blood Evidence 
• Alcohol / Drugs 

– Trace Evidence (Packaging) 
• Fingerprint 
• DNA 
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Field Response Protocols 
Forensic Laboratory Testing 

vs. Diagnostic (Health) Lab Testing 

Forensic and Diagnostic Labs have different goals: 
• Diagnostic Labs 

– Analysis of blood and other body fluids for diagnostic/treatment 
purposes 

– Rarely requires chain of custody for handling of specimens 
(exceptions: drug & blood alcohol, rape kits) 
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Local Examples 

• Examples of white powder threats or hoaxes in this 
locale in fall of 2001 

• Tests performed – pictures  

Presenter
Presentation Notes
NOTES:

Examples of white powder threats or hoaxes in this locale in fall of 2001.

Tests performed – pictures.
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   Testifying in Court 

• Who testifies on behalf of forensic laboratory? 
• What kinds of errors in specimen collection or handling 

weaken a prosecution? 
• How do you prepare for testimony? 

Presenter
Presentation Notes
NOTES:

Who testifies on behalf of forensic laboratory?

What kinds of errors in specimen collection or handling weaken a prosecution?

How do you prepare for testimony?
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Inter-lab Coordination 

• Under what circumstances will crime lab work with / 
cross over to PH lab for microbiological or chemical 
analysis? 

• What agreements are currently in place, if any, about 
who processes which kinds of specimens, or how 
specimens are shared?  What agreements are needed, if 
any?  

• How would an envelope containing both a threatening 
letter and a suspicious white powder be handled? 

Presenter
Presentation Notes
NOTES:

Envelope containing both a threatening letter and a white powder: in many jurisdictions the forensic laboratory would not want to receive the envelope and letter until the public health laboratory has examined and cultured it and either determined that there are no pathogens present or sterilized it.  If the latter, the forensic laboratory may want to be involved to be sure that the features of the letter and envelope that are important for forensic examination are not disturbed.  
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How to Reach Us  

• Names and phone numbers for key forensic laboratory 
contacts 

• Include 24-hour contact number(s) 
• Include cell-phone or pager numbers, e-mail addresses 

as appropriate 
• Give web site address for more information 

Presenter
Presentation Notes
NOTES:

Use this slide to inform the audience of contact information.
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Questions 

 
 

? ? 

? ? 

? 
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